
             
 

ACCELERATOR USER GUIDE 

Accelerator is a third-party add-in providing an integration between Outlook and Sage CRM. You can update CRM data 
from Outlook: convert emails to companies, contacts, sales and cases. With Accelerator, you can file emails, attachments 
and log call information as well as tag outbound emails to customer service issues, jobs or opportunities. Accelerator is a 
great tool that provides an alternative to the standard Sage CRM Outlook Plugin. 
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Install Accelerator 
1. Close Outlook 
2. Log into Sage CRM and click on the Accelerator tab (or My CRM > Accelerator) 
3. Scroll down and select Outlook to download and install the integration 

 

4. Click Run and follow the install instructions 
5. When asked if you want to install for all users, click No 

 

6. Select CRM Settings 
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7. Confirm your CRM path and user/password appear (if the Sage CRM Path 1 field doesn’t default with your Sage 
CRM URL, you must update it before testing) then click Test 

 

8. If all settings are correct, you will receive a Logon Succeeded message, then click OK 

 

9. Once the installation is finished, open Outlook and find the Accelerator icon in the top right corner of the Home 
tab (the checkbox confirms Accelerator has successfully connected to Sage CRM):  
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Accelerator Settings 
1. CRM Together tab 

 

2. Advanced Settings 

 

NOTE: If your corporate policies allow the use of Microsoft Outlook via the Internet and your Sage CRM instance 
is publicly accessible (i.e. accessible outside of your network), it is recommended to use the external URL (see 
below for examples of internal vs. external). 

INTERNAL: http://yourCRMServerName/crm/eware.dll/go 

EXTERNAL: http://crm.yourdomain.com/crm/eware.dll/go 

3. Settings 
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4. Documents 

 

a. Version Information 
b. Clear Data Cache  

Occasionally, the data cache needs to be cleared for troubleshooting purposes; if the clear fails, it can be 
cleared manually: 

 

5. Integrated Access (recommended settings) 
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a. Integrated Access Settings 

CRM User Name/Password = user’s Sage CRM login credentials 

b. Logon Credentials 

Use IIS AutoLogon (Default Credentials) 

c. Email Options 

Link Outlook Appt Tasks – extends the MS Outlook appointment and task function by linking it to a CRM 
Company, Person and Action (this function must be previously activated and set up on the server by our 
technicians) 

 

Make Subject Save Default – determines whether only the email message subject or the message 
subject and message content is saved as a suggestion in the dialog box 

 

Add Attachments Default – allows the user to store email attachments in the CRM document library 
and sets the storage of attachments to ‘active’ in the dialog box 

Add Embedded Images Default – saves embedded images within the email 

Activate for Tags – opens the Accelerator Pane (if closed) when a tagged email is selected 

Link To Out Send – links the standard Outlook Send button to Accelerator 

 

Auto Save Incoming Selected Email – automatically saves selected incoming emails from Outlook to 
CRM without using “Save Email” (if the email address exists in CRM) 

Email Save File – saves the email as a file (*.msg) in CRM (this function is only available if ‘Email storage 
entry’ has been previously disabled) 

http://www.mycrmmanager.com/
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Reopen Options if CRM password is incorrect – displays a dialog box prompting the entry of login 
information in case of unsuccessful connection to the CRM system 

Auto-save Tagged Emails – automatically saves selected email if it is tagged 

File using Custom Fields – enables editing of custom fields before filing email to CRM 

 

d. Other Settings 

Default check attachments Size (KB) – indicates a minimum size of attachment that will be saved . . . 
some email signatures contain logo files you don’t want to file 

Delay (ms) before searching CRM for related items – delays the automatic CRM search (this allows the 
automatic search to be delayed in case of very fast navigation and email clicks; 0 = disabled) 

Delay (ms) before dismissing error dialogs – reaction time for error messages and unsuccessful search 
results (0 = no display of unsuccessful search results/display of error messages only) 

6. Address Management 

Specifies for which email recipients automatic CRM save and automatic storage dialog box should not be enabled 
Address Management settings are tied to all three send options (Send and File, Prompt and Send, Outlook Send) 

  

NOTE: The list of excluded recipients can easily be expanded to include additional recipients by right-clicking on 
an email. Use the function: Ignore Email Address. 

http://www.mycrmmanager.com/
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Viewing Accelerator on the Outlook Screen 
1. Layout 

To change the layout of the Outlook screen to accommodate the addition of the new Accelerator Pane (which 
opens on the right side), select the View tab and click on Reading Pane and choose Bottom 

 

 

2. CRM Status for Inbox 

 

NOTE: This status field is only displayed after the first email has been saved/stored in CRM 

To display the CRM Status column (if an email has already been filed using Accelerator): 

a. Select the View tab 
b. Click on Add Columns: 
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c. Choose User-defined fields in Inbox from the available columns drop-down and select CRM Status 
d. Select Add and then move the CRM Status field toward the top of the list 

  

3. CRM Status for Subfolders 

You can add CRM Status column to each subfolder individually or create a new view that adds the status field to 
all subfolders already created. To create a new view: 

a. Click View tab 
b. Change View  
c. Manage Views 
d. New 

  

e. Enter a name for new view 
f. Check the box for All Mail and Post folders > OK  
g. Columns  
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h. Scroll down to User-defined fields in Inbox 
i. Select CRM Status 
j. Add 
k. Select CRM Status and click Move Up to place the CRM Status column where you choose > OK 
l. Select the new view just created 
m. Apply View (this applies the view to the highlighted folder, continue to next steps to apply view to all) 

  

n. View tab 
o. Change View 
p. Select new view 
q. Apply Current View to Other Mail Folders 
r. Check the box for the main folder 
s. Check the box for Apply view to subfolders > OK (all folders should now have CRM Status column visible) 

  

If you later create a new folder, you can apply your new view to by selecting the new folder and completing 
steps n, o, and p from above.   

http://www.mycrmmanager.com/
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Accelerator Menu Buttons 
By default, when you select an email, Accelerator will attempt to find a Person match in CRM using the email address in 
the ‘From’ field. If there is no match, Accelerator will start to create a Company record by parsing the email. You can 
continue to create the new Company and Person record, or search for a record. 

1. Search Entities 

Allows you to search for an entity and save an email against any existing record 

  

To view the record from the Accelerator Pane double click on the line item, this will open the Details tab and 
show you the entity page as well as access additional entities tied to that record 

 

2. Search Options 

Allows you to search by bookmarks, history, or email address 
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a. Bookmarks – lists all the records that have been bookmarked 

 

b. History – allows you to search for and select a record based on entity and date 

 

c. Parse Search – searches all email addresses associated with the selected email 

 

3. Details 

Allows you to create a new record, save an email, or choose from a list of options 

a. New – allows you to create a new entity based on the data in the email (a best practice is to first go to 
the appropriate Company record and then create a new Person, Opportunity, or Case from there) 

b. Save Email – allows you to save the email as a Communication ‘Email In’ against the current record (see 
Saving Emails under Incoming Emails for more details) 
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c. Options – applies the selected option to the highlighted email 

 

Save Attachments – allows you to save only the attachments and not the email (be sure to change the 
Document Description accordingly as it defaults with the email subject) 

 

Focus – freezes the Accelerator Pane on a specific record. This is practical because you can then assign 
multiple email messages to that CRM record without the pane changing during the automatic CRM 
search after each selected email. Freezing is indicated by a blue frame around the context screen and 
must be manually released by re-selecting Focus 

 

http://www.mycrmmanager.com/


              
  Contents 

www.mycrmmanager.com  Page 14 of 24 
 

Phone – displays the phone information and allows you to enter incoming/outgoing calls, then added to 
CRM as a communication record (calls can be made if the "callto:" function is supported by your CTI 
system, such as Skype) 

To record a communication, click on ‘Type Phone In notes’ or ‘Type Phone Out notes’ and fill in the 
details of the call 

 

Tag Email – after you select the correct entity, select Tag Email from Options to add a reference number 
to the subject line which serves to create and open the associated reference in case of incoming emails 
from the reference; this can be a Case ID or a randomly assigned number in the absence of a Case (i.e.: 
You receive an email that needs to reference an existing CRM Case > search for the Company, select the 
Case icon, find the Case, click on the small Case icon, click Tag Email; the Case ID will be referenced.) 

 

 

Reply and Tag – after you select the correct entity, select Reply and Tag from Options to create a new 
reply email to original sender, open the Accelerator Pane within the email, and add a reference ID (tag) 
to the subject line; this serves to create and open the associated record (Company, Person, or Case) in 
case of incoming emails from the reference and for other users within the organization. 
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Reply All and Tag – after you select the correct entity, select Reply All and Tag from Options to create a 
new reply email to all recipients, open the Accelerator Pane within the email, and add a reference ID 
(tag) to the subject line; this serves to create and open the associated record (Company, Person, or 
Case) in case of incoming emails from the reference and for other users within the organization. 

 

Remove Tag – allows to you remove a tag from an email 

 

New Email – after you select the correct entity, select New Email from Options, this creates a new email 
to Person selected, opens the Accelerator Pane within the email, and adds a reference ID (tag) to the 
subject line; this serves to create and open the associated Person record in case of incoming emails from 
the reference and for other users within the organization. 
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New Appointment – allows you to create a calendar Appointment linked to the selected entity  

New Task – allows you to create a Task linked to the selected entity 

The Outlook entry screen is extended with Sage CRM fields that are preset with entity data from the 
context screen for Appointments and Tasks.  

This function must be previously set up and activated for Accelerator on the Sage CRM server as well as 
in the user settings. The parameters for appointment/task synchronization must be set correctly in the 
Sage CRM server settings! 

Fill in CRM fields, search for entity the appointment/task is relevant to > Save & Close or Save & Send 
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Incoming Emails 
1. Email Matching 

When an email is received, Accelerator will search based on the email address in the From field and display the 
Person details. Accelerator attempts to match the email in the following order: 

a. Tag match – check that there is a tag and if so, search CRM based on that 
b. Person Email – check for Person with same full email address 
c. Company Email – check for a Company with matching email domain 

2. Saving Emails 

a. From your Inbox, click on the email you want to file (do not open it) 
b. Confirm the entity in the Accelerator Pane is correct 
c. When there is more than one Person/Company associated with an email address, Accelerator will 

prompt you to choose the applicable record 
d. Select Save Email button (if you save to a Company, it also saves to the default contact Person, if you 

save to a Person, it also saves to the Company, if you save to an Opportunity or Case, it also saves to the 
Company) 

 

i. Filed For 

Filed For tells the system how you want the communication record to display in CRM (default 
parameters for the information shown here are maintained in Settings) 

 

If the email has attachments, the screen will change as follows: 

http://www.mycrmmanager.com/
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Private – sets the record to be private (only the user who filed it can view in CRM) 

Attach Email as File – click to save the entire email as a .msg document in CRM 

Add Embedded Images – option to file embedded images to CRM 

Add Attachments – a list of attachments from the email is displayed – select the document(s) 
to be stored in CRM 

Insert Email Subject – displays the Subject under Details in CRM (this is the default setting) 

Insert Email Body – displays the body of the email under Details and will be saved 

 

ii. Doc Settings – allows you to specify the Communication record attributes (the fields displayed 
here can be customized to your CRM documents) 

NOTE: File using Custom Fields must be selected in Settings for this tab to be populated. 

 

http://www.mycrmmanager.com/


              
  Contents 

www.mycrmmanager.com  Page 19 of 24 
 

Clear down – if previous emails have been saved in the thread, Clear down is used to truncate 
the text below the chosen point. Access Clear down by placing your mouse at the beginning of 
the text you want to truncate and right click – any text below that point is then truncated and 
not displayed under Details in CRM: 

https://www.screencast.com/t/VRjoWdipj 

 

 

3. Finding & Displaying Stored Emails 

The Accelerator quote icon displays the list of Communications associated with the selected email address 

NOTE: Clicking on the Communications symbol to the left of the summary opens the Sage CRM record. 

  

http://www.mycrmmanager.com/
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Outgoing Emails 
1. New Email 

a. Allows you to search for and select an entity in CRM before using Send and File or selecting an Email 
Template with merged fields 

From the new email, click on the Accelerator icon > Search > Entities > Person (or Company) > enter 
name of Person (or Company) > Go > double click to select entity 

 

b. Email Address Picker – allows you to search for and select an email address saved in CRM from the 
selected entity 

i. Select the appropriate Person record > Options >Email Address Picker 
ii. select the email address > Add/Add CC/Add BCC >OK 

 

 

c. Accelerator Ribbon 
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Send and File – sends the email and files it to CRM if the email address in the To field matches an email 
address in CRM (see Email Matching under Incoming Emails for more details) 

NOTE: If there is no email address match in CRM, and you use Send and File, the email will not be filed 
to a specific record and there will be no ‘warning’ message letting you know. The email will instead be 
saved to the User’s Tasks and can be found here: 

Calendar > Select Tasks > Select Email In > Select All 

 

CRM Address Book – use your CRM data to find email addresses by filter 

 

Shared Documents – allows you to attach a Shared Document where there are CRM documents 
associated with a specific entity, they can be accessed from here and attached to an outgoing email 

 

Email Templates – accesses email templates saved in CRM, with saved attachement(s) if applicable, and 
allows you to select and send from Outlook so you can efficiently run your business and streamline 
communications (if there are merge fields, you must first select the appropriate entity – see New Email 
under Outgoing Emails for more details) 
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Email Templates continued... 
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Accelerator Information Menu 
1. Context-Specific Information 

The icons shown in the Accelerator Pane match those used in Sage CRM 

From one record, you can select and view other records tied to it. For example, from the Company record, select 
the Person icon to see a list of Persons associated with the Company. Then, click on the small Person icon from 
the list to see the Person Summary.  

 

NOTE: Data fields in green lettering indicate a hyperlink to either an executable function (i.e. website, email, 
phone call) or the corresponding entry in Sage CRM. 

a. Bookmarks 

With this option turned on, you can add/remove bookmarks. Click on the star icon from the preferred 
record to add/remove from your list. If there is no star icon, this feature is not enabled. 

 

b. Quotes and Orders  

The information offered is extended to include Quotes and Orders, if applicable, from the corresponding 
Opportunity. Click on the Quote or Order icon to see the details. 
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Contact Us 
As you install Accelerator and begin utilizing the integration, questions may arise. Please contact us via 
inquiries@mycrmmanager.com and we will promptly respond. Be sure to include details and a screen shot of the 
question/issue so we can get a jump on the resolution.  

You can also contact the publisher directly at https://crmtogether.com/products/accelerator/. 

http://www.mycrmmanager.com/
mailto:inquiries@mycrmmanager.com
https://crmtogether.com/products/accelerator/
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